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FabPro 1000 Best Practices

FabPro 1000
 
 

FabPro

1000™ 

Rev. D, P/N 45-D33
 

Original Instructions

 

NOTE: Use this page to print the Best Practices as a whole. Scroll down to the bottom of the page and click

the  button. On the page in the new tab, press ctrl+P (cmd+P on Mac) to print the

document.

NOTE: Please refer back to support.3dsystems.com/fabpro/ for the most up-to-date Best Practices.

 

Best Practices

http://support.3dsystems.com/fabpro
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FabPro/NextDent Print Material Quick Reference
You can you use the following chart as a one-stop shop for all FabPro/NextDent print material information. To print
this page, scroll to the bottom and click the Printer-friendly Version Link. On the page in the new tab, press ctrl+P
(cmd+P on Mac) to print the document. For best results, set up the print in landscape orientation and 50% scale.

Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

NextDent
Surgical Guide 1. For best results

orient the parts

flat in the build

area so the

surface fitting the

teeth is away

from the print

platform.

2. Orient drill guide

holes

perpendicular to

the XY-Plane.  If

there are multiple

drill guides at

different angles

try to orient the

part to keep them

all as

perpendicular to

the XY-Plane as

possible.

3. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle - 5
min.
After 1st use -
5 min.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr -
n/a
In tray > 3 hr -
n/a

Post-
Processing
Guide

10 min.
(see
Note 2)

®

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/nextdent-surgical-guide
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

4. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

NextDent  Model
2.0 WHT 1. For best results

use the Resin

Mixer to gently

stir between

prints and after

the resin has

been sitting

overnight.


CAUTION:
Do NOT
press
down on
the film
when
stirring.

2. Allow parts to dry

completely

before post cure.

3. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

4. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle -
2.5 hr.
After 1st use -
1 hr.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr -
30 sec.
In tray > 3 hr -
60 sec.

Post-
Processing
Guide

10
min. (see
Note 2)

®

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/nextdent-model-20-wht
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

NextDent  Model
2.0 PCH 1. For best results

use the Resin

Mixer to gently

stir between

prints and after

the resin has

been sitting

overnight.


CAUTION:
Do NOT
press
down on
the film
when
stirring.

2. Allow parts to dry

completely

before post cure.

3. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

4. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle -
2.5 hr.
After 1st use -
1 hr.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr -
30 sec.
In tray > 3 hr -
60 sec.

Post-
Processing
Guide

10
min. (see
Note 2)

®

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/nextdent-model-20-pch
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3


9/1/22, 8:30 AM FabPro 1000 Best Practices

infocenter.3dsystems.com/bestpractices/print/book/export/html/1011 6/58

Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

NextDent  Ortho
Rigid 1. For best results

orient the parts

flat in the build

area so the

surface fitting the

teeth is away

from the print

platform.

2. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

3. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle - 5
min.
After 1st use -
5 min.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr -
10 sec.
In tray > 3 hr -
30 sec.

Post-
Processing
Guide

10
min. (see
Note 2)

®

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/nextdent-ortho-rigid
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

NextDent  Model
1. For best results

use the Resin

Mixer to gently

stir between

prints and after

the resin has

been sitting

overnight.


CAUTION:
Do NOT
press
down on
the film
when
stirring.

2. Allow parts to dry

completely

before post cure.

3. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

4. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle -
2.5 hrs.
After 1st use -
1 hr.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr
- 30 sec.
In tray > 3 hr -
60 sec.

Post-
Processing
Guide

10
min. (see
Note 2)

FabPro™ Proto
GRY 1. Use orientation

to minimize large

cross sections

areas.

Video -
FabPro 1000
3D Sprint
Training

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle - 1
hr.

Post-
Processing
Guide

60
min. (see
Note 2)

®

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/nextdent-model-oker
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

2. Before each

build, make sure

there is no debris

stuck to the film,

nor floating

around in the

tray. If debris is

suspected to be

present, filter the

debris out using

a thin wire mesh

material by

pouring the

material from the

tray into the

original material

bottle or glass

jar. Clean tray as

needed and

inspect the film

for damage

before pouring

material back in.

3. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.

4. For best results

use the Resin

Mixer to gently

stir between

prints and after

the resin has

Click here for
full material
best practices

After 1st use -
10 min.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr
- 30 sec.
In tray > 3 hr -
30 sec.

http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-proto-gry
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

been sitting

overnight.


CAUTION:
Do NOT
press
down on
the film
when
stirring.

5. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

FabPro™
JewelCast GRN 1. Follow and apply

accuracy wizard

procedure for

each printer to

get highest

accuracy parts.

2. Manually check

support location

before printing.

3. In thicker cross

sections for large

rings or non-ring

geometries, go

up in cure depth

to avoid

delamination

between layers.

Go up in 10µm

increments to

Video -
FabPro 1000
3D Sprint
Training
Video -
JewelCast GRN
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle - 1
hr.
After 1st use -
10 min.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr
- 30 sec.
In tray > 3 hr -
30 sec.

Post-
Processing
Guide

30
min. (see
Note 2)

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint/printing-applications#vid01
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-jewelcast-grn
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

prevent over

curing features.

4. For parts thicker

than 3.5mm use

Heavy Mode to

print the ring. If

any cracking is

seen after

printing in Heavy

Mode, raise the

cure depth by

10µm.

5. If positive

features have

poor resolution,

the Border

Thickness

parameter in the

build style could

be increased up

to 20%. It is not

suggested to go

higher or

negative features

might get closed

or too small.

6. If detail is blurry,

check for proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

7. If detailing is still

blurred, lower

cure depth in

10µm

increments.

8. If detail remains

an issue or

accuracy is hard

to achieve run

the accuracy

wizard for this

build style.

9. Verify proper

cleaning method.

Insure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

cure.

10. Make sure all IPA

has been

evaporated off,

and allow for

parts to dry

completely. If

surface finish is

still shiny and not

matte after

cleaning, not all

resin has been

removed and it

will show up in

the casting.

Repeat cleaning

and drying until
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

parts do not have

any excess

material.

FabPro™ Tough
BLK 1. Use orientation

to minimize large

cross sections

areas.

2. Before each

build, make sure

there is no debris

stuck to the film,

nor floating

around in the

tray. If debris is

suspected to be

present, filter the

debris out using

a thin wire mesh

material by

pouring the

material from the

tray into the

original material

bottle or glass

jar. Clean tray as

needed and

inspect the film

for damage

before pouring

material back in.

3. Follow and apply

accuracy wizard

procedure for

each printer to

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle -
n/a
After 1st use -
n/a
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr
- 30 sec.
In tray > 3 hr -
30 sec.

Post-
Processing
Guide

150
min. (see
Note 2)

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-tough-blk
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

get highest

accuracy parts.

4. For best results

use the Resin

Mixer to gently

stir between

prints and after

the resin has

been sitting

overnight.


CAUTION:
Do NOT
press
down on
the film
when
stirring.

FabPro™ Elastic
BLK 1. In 3D Sprint, use

the Orient tool to

minimize large

cross-

sectional areas.

2. Before each

build, make sure

there is no debris

stuck to the film,

nor floating

around in the

tray. If debris is

suspected to be

present, filter the

debris out using

a thin wire mesh

material by

pouring the

material from the

tray into the

original material

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle - 1
hr.
After 1st use -
10 min.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr
- 30 sec.
In tray > 3 hr -
30 sec.

Post-
Processing
Guide

45
min. (see
Note 2)

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-elastic-blk-0
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

bottle or glass

jar. Clean tray as

needed and

inspect the film

for damage

before pouring

material back in.

3. For best results

use the Resin

Mixer to gently

stir between

prints and after

the resin has

been sitting

overnight.


CAUTION:
Do NOT
press
down on
the film
when
stirring.

4. Remove parts

from print

platform soon

after printing.

Remove large

parts within six

hours of the end

of a print, and all

smaller parts

within 24 hours

from the end of a

print. Due to the

elastic nature of

the material, and

gravity, failure to

do this risks the

part detaching
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

from the print

platform and

falling into the

print tray. This

will cause a resin

spill and partially

cured resin to be

left in the tray. It

can also damage

your build.

5. Verify proper

cleaning method.

Ensure cleaning

solvents are not

saturated and

parts are allowed

to dry before

post-curing.

6. To get best

surfaces, cut

supports off of

part before post-

curing.

7. Advanced users

who would like to

try to print flat-

bottom parts,

such as gaskets,

directly on the

print platform

without supports

may do so by

taking the

following steps in

3D Sprint:
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

a. Go to Build

Style >

Advanced.

b. Scroll down

and set the

Min. Support

Height field to

0. Then click

Apply.

c. In 3D Sprint,

use the

Transform

tool to move

parts to sit

flush on the

bottom of the

grid (print

platform).

8. Verify print tray is

full of material

before printing.
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Print Material
Part Quality and
Accuracy Tips

3D Sprint
Orientation /
Supports
Guides

Resin Mixing
Instructions 

Part-
Cleaning
Info.

Part-
Curing
Time

FabPro™ Flexible
BLK 1. Use orientation

to minimize large

cross-sectional

areas.

2. Orient part to

print non-flat

surfaces. Flat

surfaces may

show more

support scarring

than other

FabPro materials.

3. Verify proper

cleaning method.

Ensure cleaning

solvents are not

saturated and

parts are allowed

to dry before post

curing.

Video -
FabPro 1000
3D Sprint
Training
Click here for
full material
best practices

Pre-mix resin
on LC-
3DMixer before
pouring
New bottle - 1
hr.
After 1st use -
10 min.
(see Note 1)

Mix resin in
resin tray
before printing
In tray < 3 hr
- 30 sec.
In tray > 3 hr -
30 sec.

Post-
Processing
Guide

60
min. (see
Note 2)

NOTE 1: Considerations for resin that has been sitting, unused, for over 1 month - If you have a resin bottle
like this, simply treat it like a new bottle and mix it for the time specified in the "Brand-new bottle" column in
the above chart. Instead of using the bottle mixer, you may opt to mix the material bottle by hand, shaking it
vigorously in an up-and-down motion. Shake it for five minutes for a new material or for one you are treating
as new (see above note). Shake the bottle for two minutes for a recently used bottle.  Please see the
section Begin Your Print Job for more information.

NOTE 2: Ensure that you place the build in your UV curing oven in the same orientation it was printed in, as if
the bottom of the oven is the print platform.

3D Sprint

General Tips
The following section will help you in basic orientation of 3D models in 3D Sprint software.

http://infocenter.3dsystems.com/videolibrary/fabpro-training-videos/3d-sprint
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-flexible-blk
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note2
http://infocenter.3dsystems.com/fabpro1000/post-processing
http://infocenter.3dsystems.com/bestpractices/print/book/export/html/1011#note3
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General Tips
The most-common tools you will use are:

The Transform Tool allows you to move, rotate, and scale your 3D model in the print area.

The Auto Place Tool automatically places your 3D model in the optimal part of the print area.

The Combine/Separate Tool allows you to select and combine subparts to create a new part, as well as
separate a combined part into its subparts.

The Smart Support Tool allows you to create supporting architecture for your print job. Supporting
architecture both holds the printed part on the print platform, and supports the architecture of the part so that
it keeps it shape during printing.

The Orient Tool allows you to automatically orient parts on the print platform, or select the face of the 3D
model to align with the platform.

If you are using a smaller computer screen, some tools might be hidden under the "MORE" dropdown menu.

 

Part Tilting

Tilt Single Model
Tilting objects optimizes cross-sectional area for printing, and enables finer part-surface quality and uniformity on
surfaces. A tilted orientation is especially recommended for parts with large flat sections. This section describes
how to best tilt objects for inverted-SLA printers.

1. Click on your part model to select it.
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2. Click the Transform Tool and then the   button.

3. This will create anchors on the 3D model, which you can click and drag

to resize your model. Resize the model until it is small enough to fit on

the print platform, and until it is at your desired dimensions.

4. Click the Auto Place Tool and click the   button.
 

5. Click the Orient Tool and select the Support Area radio button.

6. Keep the default setting of 30 deg and click the Orient button. The other

recommended setting you may use is 15 deg.

Combined Parts

1. Combined parts will be oriented together and will be placed in undesirable

positions.

2. Click the Combine/Separate Tool and click the   button.

3. Click the combined part to select it and click the   button.

4. Both parts may not fit in the print area as they are. They might need to be scaled

and/or moved to fit. There are two ways to tell if a part does not fit in the print

area:


a. The item is marked with a red exclamation point in a circle in the Parts List

menu.

b. The model is outlined in red in the printable area.
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5.  To scale the parts down, click and drag a box around the parts to select them

as a group. Use the Transform Tool, as in Step 2 of the above section Tilt Single

Model.

6. With the parts still selected, click the Auto Place Tool, and then click the Set

button.

Advanced Placing Techniques
You may wish to alter the models beyond simply auto-placing them.

1. Use the Move and Rotate functions within the Transform dialog window

to reorient your part(s) so that any flat parts are in a vertical orientation.

2. To print a part with as few supports as possible, ensure that the

sections of your part(s) that have a continuously connected surface are

facing the print platform as much as possible. In the example at the

right, the arrows point to sections with a continuous surface. Consider

the following examples:

 

a. In this example, the side of the part with fine details faces the

print platform. The supports must connect at many places to

support the structure, causing a lot of supports to be created.
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b. In this example, the same part is oriented such that the parts

with the least amount of details are facing the print platform.

Less supports are needed, making for a more-ideal print job.

3. Ensure that there are enough supports along the sections of your part

that have the most changes in geometry. Pay particular attention to the

areas closest to the print platform, as these will be the first parts that

attach to the supports- the highest density of supports should be

concentrated on these areas. The image at the right shows an example

of a high density of nodes near the platform. You may need to reinforce

areas such as these with more supports, depending on the size and

geometry of the part.

a. Toggle between Flat and Tilted settings in the

PRESET dropdown menu, and then click UPDATE SUPPORTS,

to see if either preset distributes the nodes more evenly and at

a better density.

b. If there are still gaps in the parts, use the Add/Erase buttons

under the Modify tab to manually add/edit your supports.

Ensure you are using POINT mode. Click the ADD or ERASE

buttons to go into that mode. Click on the green diodes you

wish to erase, or click on areas where you wish to add a diode.

Click the UPDATE SUPPORTS button.

4. Parts that don't have large flat areas, and less than 2mm wall thickness, may be printed in either Flat or Tilted preset

modes, provided that you still inspect the supports for proper placement, continuity, and density near the platform.
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Consider the following examples:

The way this part is oriented, there are many changes in elevation facing the
print platform, and there are many floating parts that must be supported.
This causes many supports to be necessary, and at staggering heights.

If the same part is oriented with the longest, flattest portion facing down
and slanted, most of the supports are so evenly spaced and consistent that
a line can be drawn through them. There are just a couple of extra support
sets sticking up to support floating geometry. This is ideal.

 

Support Anchor Placement
When creating supports automatically, the supports that are generated might not always be the most-optimal. This
section will show you how to modify supports by adding or erasing support anchor points.

1. Ensure that the part(s) are properly oriented before before generating

supports. If you have multiple parts, it is best to group them together by

using the Combine/Separate Tool. Click this tool in the top menu.

2. Ensure that  is selected. Click and drag a square around

the parts to select them.

3. Click 
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4. Now, when you generate supports, they will connect the two parts

together. Generate supports using the Smart Supports dialog window.

5. Support anchors can be changed by clicking in the Modify tab of the

Smart Supports dialog window.

6. Add supports by clicking the ADD button and clicking an area on the

surface of a part where another support is needed.

7. Erase supports by clicking the ERASE button and clicking the green

anchor sphere(s) where you no longer want supports.

General Tips on Adding/Erasing Supports
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1. Supports in the middle of sidewalls are generally not necessary. Delete

supports like the one circled at the right.

2. Anchors that appear under the part, in relation to the print platform, should

be deleted.

 

Materials

FabPro Proto GRY
A fast, general purpose plastic material ideally suited for industrial applications. The FabPro’s precision printing in
this opaque gray material highlights fine features and is ready for finishing and painting, perfect for high quality
prototypes and models.

Part Quality and Accuracy Tips
In order to achieve good accuracy with PROTO GRY it is important to follow the part setup instructions below for
orientation and supports. Some other key tips are as follows:

1. Use orientation to minimize large cross sections areas.

2. Before each build, make sure there is no debris stuck to the film, nor floating around in the tray. If debris is suspected to

be present, filter the debris out using a thin wire mesh material by pouring the material from the tray into the original

material bottle or a glass jar. Clean tray as needed and inspect the film for damage before pouring material back in the

tray.

3. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

4. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.


CAUTION:  Do NOT press down on the film when stirring.

5. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

 



9/1/22, 8:30 AM FabPro 1000 Best Practices

infocenter.3dsystems.com/bestpractices/print/book/export/html/1011 25/58

Orientation
Part orientation is the first critical setup function before slicing a part in 3DSprint™. The part orientation must
consider several features before adding supports to the part. The optimal orientation may not be intuitive at first, but
the orientation is based on the premise of printing on a 3D printer one layer at a time. The goal of this document is to
allow the customer to build that orientation skill and intuition.

Tip 1 - Identify No Support Surfaces-

The first thing to consider for a part is to determine what surfaces or features should NOT have a support.

NOTE: In 3DSprint™for FabPro™, this will be surfaces facing AWAY from the print platform or ‘floor’ (checker
board plane in the illustration below) of 3DSprint™. Thus, surfaces such as datums, textured surfaces, and
outer cover surfaces should be oriented for no supports.

Figure 1. Initial part orientation in 3DSprint™

 

Tip 2 - Large Cross Sectional Area

To get the best surface quality and accurate part, minimizing the cross sectional area is very important. Use the
Transform function in 3DSprint™to rotate the part such that it satisfies Tip 1 and Tip 2.

NOTE: It is also useful to use the View window to click on the Top Left triangle of Z in the Clipping section.
This will create a plan that can be moved up and down in Z to view the slice image of the layer being printed.
In other words, what is seen in Red is what is being printed in that layer.

Figure 2. Initial part orientation and View window in

3DSprint™
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Figure 3. Cross section area view in XY plane using Z-

axis clipping in View. Red denotes the layer information.

 
To see the large cross sectional area for this part, move the blue plane down. This is a large cross section that would
be better printed in an angular rotated orientation. Note a Large Cross Section can be considered to be a cross
section that is greater than a 20x10mm or 8x30mm area. This should be defined as being in a local area and not the
full area of the layer. The figure shows an area that has four large cross sectional local areas.

Figure 4. Large cross sectional area. Shows four sides

with approximate 10x30mm cross sectional areas.

 
Continue to move the blue plane up and down along the Z-axis to identify the large cross section areas in the part.
The area below shows a part that is approximately 8x35mm in two local areas.

Figure 5. Large cross sectional area. Shows two areas

with approximate 8x35mm cross sectional areas.

 

Tip 3 – Critical Feature Orientation
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A critical feature is a feature for which you would prefer minimal or no supports, such as a screw boss, snap, or other
critical geometry.  On the part in this example, there is a screw boss on one side of the part. For these features, it is
optimal to rotate the part so they are facing away from the print platform.

NOTE: These surfaces may have minimal supports (minimal meaning <5), but not in such a way the support
interferes with the critical function of the feature. Note manual editing may also be required on these
features.

 
Enable Tip 1, Tip 2, and Tip 3  – Once considering the items described in Tips 1-3, the part can be oriented. The
Transform window in 3DSprint™can be used to orient the part back 45-degrees toward the Y-axis. Note the change in
cross section being printed on this layer compared to the orientation in Figure 5. The following images show the
considerations from Tip 1-3.

Figure 6. Re-oriented part after following Tip 1 for no

support surface.

 

Figure 7. Re-oriented part after following Tip 2 for small

cross sectional area.

 

Figure 8. Re-oriented part after following Tip 3 for

feature location.

 

Tip 4 – Minimizing Supports Using Self Supporting Orientation

Before adding supports, it is important to orient the parts to be self-supporting. This includes orienting the part such
that larger sections of the part are at approximately 45° relative to the print platform. Consider the example in
Figures 9 and 10 below, where large, straight edges have been oriented 45° from the print platform.
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Figure 9. Top of center hole is parallel to the print

platform.

 

Figure 10. Top of center hole is now at a self supporting

angle to the print platform.

 
The part in the image below is now ready to add supports. It has used the following information to optimally orient
the part:
Tip 1 - Identify No Support Surfaces – Cover area has been considered and no supports are on top surfaces of the
part. There is minimal supports on the side of the outer surface wall.
Tip 2 - Large Cross Sectional Area – The large cross sectional areas were identified and have been optimized.
Tip 3 – Critical Feature Orientation – The critical features of the large holes and screw boss have been oriented for
minimal supports.
Tip 4 – Minimizing Supports Using Self Supporting Orientation – The final orientation moves the part such that it
minimized edges parallel to the print platform.

Figure 11. Final orientation after following Tips 1-4.
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Add Supports
Supporting the part is another critical function for getting successful accurate parts. Once the part has been
optimized for orientation, then the supports can be added. TOUGH BLK print material has two default support styles
which have been optimized for that particular material. These support styles are fZlat and Tilted. The Flat and Tilted
refer to the part orientation. Sometimes a part will need to be printed in a flat orientation and, thus, the supports are
optimized for that; it is likewise for a tilted part.

Tip - 1 Flat Supports

The Flat supports are designed to be conservative in that they will cover a large span of geometries. This will also
lead to the need to manually remove some supports before printing. The following is an example of a flat part and
the manual editing of the supports. It is printed flat in order to optimize the round sections of the part.

Figure 12. Part in flat orientation.

 
Go to Smart Supports and select the Flat support style to generate the default supports.

Figure 13. Part in flat orientation with default supports.

 
Rotate the part to see the bottom view and the threads of the part. In most cases, screw threads do not need any
supports.
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Figure 14. Due to the geometry and the conservative

approach for the Flat supports, there will be areas that

require manually removing some anchor points to

prevent excess support scarring.

 
Go to the Modify tab to manually remove anchor points. It is important to maintain anchor points in areas as shown
below to get the most accurate part. This includes properly supporting large radii on the bottom and inside of the top
of a hole.

Figure 15. Modified anchor points using support tools.

 

Figure 16. Anchor points are removed from threads on

part.

 

Tip-2 Tilted Supports

The Tilted supports are designed to be conservative in that they will cover a large span of geometries. This will also
lead to the need to manually remove some supports before printing. The following is an example of a tilted part and
the manual editing of the supports. It is printed in a tilted orientation in order to optimize the flat surfaces of the part.
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Figure 17. Part in tilted orientation.

 

Figure 18. Part in tilted orientation with default

supports.

 
Go to the Modify tab and rotate the part to check for excess anchor points. One signal for too many anchor points is
a line of supports on a flat functional wall. It is optimal to have fewer supports on a functional surface to reduce the
post processing of the part.

Figure 19. Note lines of anchor points on functional wall

surface.

 
However, it is necessary to know the bottom side of the part as it may need the excess supports to maintain the
flatness of the part.
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Figure 20. The bottom side of the part has full sharp

edge anchor points as well as some infill anchor points

to maintain a flat part bottom.

 
Go to the Modify tab to manually remove excess anchor points. It is important to maintain anchor points in areas as
shown below to get the most accurate part. This includes properly supporting large radii on the bottom and inside of
the top of a hole.

Figure 20. Anchor points are optimized on the functional

wall without sacrificing part accuracy.

FabPro Tough BLK
A durable plastic material for producing black parts for functional prototyping and production parts. Combined with
the versatility, reliability and small footprint of the FabPro, this tough material provides a solution to create
mechanical assemblies, fit testing prototypes and functional parts.

Part Quality and Accuracy Tips
In order to achieve good accuracy with TOUGH BLK it is important to follow the part setup instructions below for
orientation and supports. Some other key tips are as follows:

1. Use orientation to minimize large cross sections areas.

2. Before each build, make sure there is no debris stuck to the film, nor floating around in the tray. If debris is suspected to

be present, filter the debris out using a thin wire mesh material by pouring the material from the tray into the original
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material bottle or glass jar. Clean tray as needed and inspect the film for damage before pouring material back in.

3. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

4. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.


CAUTION: Do NOT press down on the film when stirring.

5. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

Orientation
Please see Orientation section for FabPro Proto GRY.

Add Supports
Please see Add Supports section for FabPro Proto GRY.

FabPro JewelCast GRN
A green material ideal for small, fine featured jewelry master patterns for gypsum investment casting applications.
This material leaves minimal ash after burnout to produce superior casting quality. Create and produce custom
jewelry or other investment castings that capture fine detail with a smooth surface finish.

Part Quality and Accuracy Tips
In order to achieve good accuracy with JewelCast-GRN, it is important to follow the part setup instructions below for
orientation and supports. Some other key tips are as follows:

1. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

2. Manually check support location before printing.

3. In thicker cross sections for large rings or non-ring geometries, go up in cure depth to avoid delamination between layers.

Go up in 10µm increments to prevent over curing features.

4. For parts thicker than 3.5mm use Heavy Mode to print the ring. If any cracking is seen after printing in Heavy Mode, raise

the cure depth by 10µm.

5. If positive features have poor resolution, the Border Thickness parameter in the build style could be increased up to 20%.

It is not suggested to go higher or negative features might get closed or too small.

6. If detail is blurry, check for proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to

dry before post cure.

7. If detailing is still blurred, lower cure depth in 10µm increments.

8. If detail remains an issue or accuracy is hard to achieve run the accuracy wizard for this build style.

9. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

10. Make sure all IPA has been evaporated off, and allow for parts to dry completely. If surface finish is still shiny and not

matte after cleaning, not all resin has been removed and it will show up in the casting. Repeat cleaning and drying until

parts do not have any excess material.

Orientation
The orientation for thick parts is best when oriented vertically to minimize supports.

http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-proto-gry#orientation
http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-proto-gry#add-supports
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Figure 1. Ring print orientation in 3DSprint

 

Add Supports – Full Arches
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified.
Jewelry parts will need to be checked manually to verify supports are on the correct part of the rings to prevent
damage to the part during support removal. In 3DSprint start by viewing the rings from the bottom-up.

Thin and Multiple band Ring Geometry

Rings with thin bands and multiple-band geometry need to be properly supported to maintain roundness of all bands.

Figure 2. Ring view from bottom-up.

 
Go to the Analyze tab in the Smart Supports and Update Placement to view the default supports. Many of these
supports will need to be removed.
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Figure 3. Default support placement.

 
After loading the default supports go to the Manual Tab to remove supports. Remove the supports that are on the
crown. Note also that this part of the ring is mostly self-supporting. The reason the software adds these supports is
that the default supports must cover all general parts. Thus, the support coverage will be conservative for reliability.

Figure 4. Manually edited support removal result.

 
Use the Clipping function in the View window to scroll thru the part to see if any anchor points are on the inside that
need to be removed.
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Figure 5. This ring has many anchor points that need to be removed from the inside of the

part.

 

Figure 6. This ring has the anchor points removed from the inside of the part.

 
Next, be sure to remove anchor points from features that can be self-supporting.
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Figure 7. The ring on the right has the feature anchor point removed.

 
The band and underside of the crown are the ideal places to support. This is because support removal is easy and
less likely to scar the part in these areas. Support the extra bands with more anchor points at the starting area of the
ring.

Figure 8. Anchor points added to starting point 2nd and

3rd bands of the ring.

 
To maintain roundness of the part during printing, add anchor points at intervals going up the ring sides. Ensure all
bands of the ring are supported.
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Figure 9. Anchor points added to starting point 2nd and

3rd bands of the ring.

 

Figure 10. Ring with final support solution.

 
The tips can be made smaller if desired by using  The Pillar Top Ratio parameter in the Tip section.
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Figure 11.The Pillar Top Ratio parameter is highlighted with a star.

 

Figure 12. Note the support tip change by making the Pillar Top Ratio 0.3 rather than 0.15.

 

Wide Band Ring Geometry

Rings with wide bands require more anchor points on the bottom half of the ring band. This will help maintain the
roundness of the ring and control the shape of the bottom of the ring to minimize post processing.
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Figure 13. Wide band ring.

 
The default anchor points on the ring band will not be enough to maintain the shape.

NOTE: Because the manual support editing is necessary, the 3DSprint software defaults to less supports so
removing supports and adding supports is easier for the user.

Figure 14. Default anchor points on thick ring band.
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Figure 15. Modified anchor points on thick ring band.

FabPro Elastic BLK
A design elastomer.

Part Quality and Accuracy Tips

1. Before each build, make sure there is no debris stuck to the film, nor floating around in the tray. If debris is suspected to

be present, filter the debris out using a thin wire mesh material by pouring the material from the tray into the original

material bottle or glass jar. Clean tray as needed and inspect the film for damage before pouring material back in.

2. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.


CAUTION: Do NOT press down on the film when stirring.

3. Remove parts from print platform soon after printing. Remove large parts within six hours of the end of a print, and all

smaller parts within 24 hours from the end of a print. Due to the elastic nature of the material, and gravity, failure to do

this risks the part detaching from the print platform and falling into the print tray. This will cause a resin spill and partially

cured resin to be left in the tray. It can also damage your build.

4. Verify proper cleaning method. Ensure cleaning solvents are not saturated and parts are allowed to dry before post-

curing.

5. To get best surfaces, cut supports off of part before post-curing.

6. Verify print tray is full of material before printing.

Orientation
Please see Orientation section for FabPro Proto GRY.

Add Supports

http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-proto-gry#orientation
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Please see Add Supports section for FabPro Proto GRY.
Advanced users who would like to try to print flat-bottom parts, such as gaskets, directly on the print platform
without supports may do so by taking the following steps in 3D Sprint:

1. Go to Build Style > Advanced.

2. Scroll down and set the Min. Support Height field

to 0. Then click Apply.

3. Use the Transform tool to move parts to sit flush on the

bottom of the grid (print platform).

FabPro Flexible BLK
FabPro™ Flexible BLK is a material suited for prototyping, and offers high strength and stability for production
applications. Producing parts in a fraction of the time required to produce molded parts, this material accelerates the
design and iteration of new concepts with flexible, durable, functional prototypes for industrial and consumer goods
applications.

Accuracy Tips
In order to achieve good accuracy with Flexible BLK, it is important to follow the part setup instructions below for
orientation and supports. Some other key tips are as follows:

1. Use orientation to minimize large cross-sectional areas.

2. Orient part to print non-flat surfaces. Flat surfaces may show more support scarring than other Figure 4 materials.

3. Verify proper cleaning method. Ensure cleaning solvents are not saturated and parts are allowed to dry before post

curing.

NextDent Surgical Guide
NextDent SG is a biocompatible Class I material, developed for the printing of Surgical Guides for implant surgery
use. Because of the high precision of this material it is easy to insert drill sleeves, directly after printing. Enabling
even greater precision during surgery. The properties of NextDent SG will not change by using disinfectants.
In addition, the material can also be sterilized using standard autoclave protocols. The use of an autoclave does not
affect the dimensional stability, therefore NextDent SG can be used in every operating theater.

http://infocenter.3dsystems.com/bestpractices/dlp-best-practices/3d-sprint-best-practices-fabpro-1000/materials/fabpro-proto-gry#add-supports
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Part Quality and Accuracy Tips
In order to achieve good accuracy with SG materials it is important to follow the part setup instructions below for
orientation and supports. Some other key tips are as follows:

1. For best results orient the parts flat in the build area so the surface fitting the teeth is away from the print platform.

2. Orient drill guide holes perpendicular to the XY-Plane.  If there are multiple drill guides at different angles try to orient the

part to keep them all as perpendicular to the XY-Plane as possible.

3. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

4. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

Orientation - Partials
Orient part with the top of the teeth facing down into the grid on 3DSprint™. Use Transform functions to orient part
such that the drill guides are as vertical as possible.

Figure 1. Front view of surgical guide part.

 

Figure 2. Top view of surgical guide part.

 
Use the Clipping features under view to verify the verticality of the drill guide.
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Figure 3. Clipped view of drill guide hole in surgical

guide part.

 

Add Supports - Partials
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified.

Figure 4. Front view of supported surgical guide part.

 
Note supports should be removed from all numbers or lettering and from any area that will cause an obstruction
when inserting the drill guide.

Figure 5. View of lettering and drill guide hole showing support nodes in surgical guide part.

 
Remove the nodes using the tools under the Modify Tab.



9/1/22, 8:30 AM FabPro 1000 Best Practices

infocenter.3dsystems.com/bestpractices/print/book/export/html/1011 45/58

Figure 6. Smart Support Window with function tabs

including Modify tab

 

Figure 7. View of lettering and drill guide hole showing support nodes removed in surgical guide part.

 

Figure 8. Clipped view of drill guide hole before and after nodes are removed from surgical guide part.
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Once supports have been modified, the part is ready to print.

Figure 9. Properly oriented and supported surgical guide

part.

 

Orientation – Full Arches
Orient part with the top of the teeth facing down into the grid on 3DSprint™. The choice here is going to be speed vs
drill guide verticality. For print speed, orient the part such that the part is as flat as possible. For drill verticality, use
Transform functions to orient part such that the drill guides are as vertical as possible.

Figure 10. Surgical guide full arch.

 

Figure 11. View of surgical guide full arch oriented to

optimize print speed.
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Figure 12. View of surgical guide full arch re-oriented to optimize drill guide verticality.

 

Add Supports – Full Arches
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified.

Figure 13. Isotropic view of supported surgical guide full

arch oriented for drill guide verticality.

 
It may be necessary to ADD supports for print reliability and optimal accuracy. For surgical guide parts, this normally
occurs when the automatically generated supports do not provide enough supports on the near flat surfaces of the
teeth.

Figure 14. Bottom view of supported surgical guide full arch oriented for drill guide verticality with extra nodes added for

a more reliably supported print to the image on the right.

 

Figure 15. Bottom view of supported surgical guide full arch oriented for print speed with extra nodes added for a more

reliably supported print to the image on the right.
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Figure 16. Isotropic view of supported surgical guide full

arch oriented for drill guide verticality.

NextDent Model
NextDent Model is characterized by its high-precision dental model prints.

Part Quality and Accuracy Tips
In order to achieve good accuracy on Model Oker materials it is important to follow the part setup instructions below
for orientation and supports. Some other key tips are as follows:

1. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.


CAUTION: Do NOT press down on the film when stirring.

2. Allow parts to dry completely before post cure.

3. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

4. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

Orientation - Arches
Most Model Oker parts are intended to print flat or the bottom surface being parallel to the XY-plane grid on
3DSprint™. The exception is when the model has large cross sectional areas on a full plate part.
For arches, use Orient functions to orient part such that the bottom surface is parallel to the XY-plane grid.

Figure 1. Isotropic view of model part not parallel XY-

plane grid.

 
The Manual selection in the Orient function allows the user to select the base of the part. Once chosen, selecting
SET BASE will auto orient the part to be flat.
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Figure 2. The Orient function window with

Manual/Set Base selected.

 

Figure 3. The small blue circle denotes the bottom of the

part to be aligned parallel to the XY-plane.

 

Figure 4. The model arch is now flat or parallel to the XY-

plane.

 

Orientation- Full Palate Models
For models with a full palate and/or very large cross sectional areas. Angle the model as to reduce the number of
surfaces parallel to the XY plane.

Figure 5. Full Palate model with large cross sectional

area.
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Rotate the part and then use the Z-Clipping Tool in the View window to see the cross sectional areas of the part. Find
the largest cross section and then rotate the part 15-30 degrees to reduce the cross sectional area.

Figure 6. Cross sectional view of full palate model using Z-Clipping tool.

 

Figure 7. Cross sectional view of full palate model using Z-Clipping tool at largest cross

section.

 

Figure 8. Right side view of full palate model oriented

parallel to XY-plane.
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Figure 9. Right side view of full palate model oriented at

angle to reduce cross section.

 

Figure 10. Cross sectional view of full palate model using Z-Clipping tool at largest cross

section after rotation.

 

Add Supports – Full Arches
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified. The supports should only be on the bottom surface of the part.

Figure 11. Bottom view of supported arch with model

arch parallel to XY-plane.

 

NOTE: supports should be removed from all numbers or lettering using the Modify tab tools under Smart
Support.
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Figure 12. Nodes in lettering of part.

 

Figure 13. Node removed from lettering of part.

 

Add Supports – Tooth Inserts
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified. The supports should only be on the bottom surface of the part.
Tooth inserts should not have any supports on the fitting surface.

Figure 14. The tooth shows nodes on the fitted surface

of the tooth insert.

 

Figure 15. The tooth shows nodes removed from the

fitted surface of the tooth insert.

NextDent Model 2.0 WHT/PCH
NextDent Model 2.0 is characterized by its high degree of accuracy, making this material suitable for detailed master
prosthodontic and orthodontic models where high precision is needed. The models show highly visual details due to
color and opacity and has an ideal surface for scan impressions.
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The accurate printed models are the perfect base for creating your dental work piece. Available in colors Peach and
White.

Part Quality and Accuracy Tips
In order to achieve good accuracy on Model 2.0 materials it is important to follow the part setup instructions below
for orientation and supports. Some other key tips are as follows:

1. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.


CAUTION: Do NOT press down on the film when stirring.

2. Allow parts to dry completely before post cure.

3. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

4. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

Orientation - Arches
Most Model 2.0 parts are intended to print flat or the bottom surface being parallel to the XY-plane grid on 3DSprint™.
The exception is when the model has large cross sectional areas on a full plate part.
For arches, use Orient functions to orient part such that the bottom surface is parallel to the XY-plane grid.

Figure 1. Isotropic view of model part not parallel XY-

plane grid.

 
The Manual selection in the Orient function allows the user to select the base of the part. Once chosen, selecting
SET BASE will auto orient the part to be flat.

Figure 2. The Orient function window with

Manual/Set Base selected.
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Figure 3. The small blue circle denotes the bottom of the

part to be aligned parallel to the XY-plane.

 

Figure 4. The model arch is now flat or parallel to the XY-

plane.

 

Orientation- Full Palate Models
For models with a full palate and/or very large cross sectional areas. Angle the model as to reduce the number of
surfaces parallel to the XY plane.

Figure 5. Full Palate model with large cross sectional

area.

 
Rotate the part and then use the Z-Clipping Tool in the View window to see the cross sectional areas of the part. Find
the largest cross section and then rotate the part 15-30 degrees to reduce the cross sectional area.

Figure 6. Cross sectional view of full palate model using Z-Clipping tool.
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Figure 7. Cross sectional view of full palate model using Z-Clipping tool at largest cross

section.

 

Figure 8. Right side view of full palate model oriented

parallel to XY-plane.

 

Figure 9. Right side view of full palate model oriented at

angle to reduce cross section.
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Figure 10. Cross sectional view of full palate model using Z-Clipping tool at largest cross

section after rotation.

 

Add Supports – Full Arches
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified. The supports should only be on the bottom surface of the part.

Figure 11. Bottom view of supported arch with model

arch parallel to XY-plane.

 

NOTE: supports should be removed from all numbers or lettering using the Modify tab tools under Smart
Support.

 

Figure 12. Nodes in lettering of part.

 

Figure 13. Node removed from lettering of part.

 

Add Supports – Tooth Inserts
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports
and determine how they may need to be modified. The supports should only be on the bottom surface of the part.
Tooth inserts should not have any supports on the fitting surface.
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Figure 14. The tooth shows nodes on the fitted surface

of the tooth insert.

 

Figure 15. The tooth shows nodes removed from the

fitted surface of the tooth insert.

NextDent Ortho Rigid
NextDent Ortho Rigid is a biocompatible Class IIa material developed for digital manufacturing of splints. In
combination with suitable software, it is possible to easily design and print splints.

Part Quality and Accuracy Tips
In order to achieve good accuracy with Ortho Rigid it is important to follow the part setup instructions below for
orientation and supports. Some other key tips are as follows:

1. For best results orient the parts flat in the build area so the surface fitting the teeth is away from the print platform.

2. Verify proper cleaning method. Insure cleaning solvents are not saturated and parts are allowed to dry before post cure.

3. Follow and apply accuracy wizard procedure for each printer to get highest accuracy parts.

Orientation- Full Arches
All Ortho Rigid parts are intended to print flat or the bottom surface being parallel to the XY-plane grid on 3DSprint™.
Use Orient functions to orient part such that the bottom surface is parallel to the XY-plane grid.
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Figure 1. Isotropic view of arches parts parallel XY-plane

grid.

 

Figure 2. The Orient function window with

Manual/Set Base selected.

 
The Manual selection in the Orient function allows the user to select the base of the part. Once chosen, selecting
SET BASE will auto orient the part to be flat.

Add Supports- Full Arches
Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports to
verify the placement and ensure they are only on the bottom surface of the part.

Figure 3. The arch is supported correctly.
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